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Working with Cisco ANA PathTracer

This chapter describes how to view a network path between two network objects using Cisco ANA 
PathTracer:

• In a circuit-switched network, like Frame Relay or ATM, or

• In packet-switched networks, like Ethernet and IP. 

In addition, it describes the Cisco ANA PathTracer working environment and the functionality available 
when using Cisco ANA PathTracer.

• Overview, page 9-1, describes the Cisco ANA PathTracer single and multi-path route tracing 
functionality and the information that can be viewed in the two main Cisco ANA PathTracer 
windows.

• Opening Cisco ANA PathTracer, page 9-2, describes how to open Cisco ANA PathTracer.

• Cisco ANA PathTracer Multi-Path Window, page 9-4, describes the Cisco ANA PathTracer 
multi-path window working environment and the information that can be viewed.

• Cisco ANA PathTracer Single-Path Window, page 9-7, describes the Cisco ANA PathTracer 
single-path window working environment and the information that can be viewed.

• Viewing Path Information, page 9-12, describes how to view information about the path between 
two network objects, including ingress and egress port information.

• Saving and Opening Cisco ANA PathTracer Map Files, page 9-13, describes how to export the maps 
(paths) displayed in the Cisco ANA PathTracer multi-path window to an .xml file.

• Saving Cisco ANA PathTracer Counter Values, page 9-13, describes how to export the counter 
values of the path displayed in the Cisco ANA PathTracer single-path window to a .csv file.

• Rerunning a Path and Making a Comparison, page 9-14, describes how to rerun a path using a 
previously saved map file with the same source and destination and then compare the paths.

Overview
Cisco ANA PathTracer enables end-to-end route tracing to be performed with informative performance 
information displayed simultaneously for the multiple networking layers. Upon receiving a path's start 
and endpoint, Cisco ANA PathTracer visually traces the route through the network. For example, in an 
ATM network environment, Cisco ANA PathTracer identifies all information regarding the connection 
of a subscriber to a provider, including all ATM PVCs, ATM switching table, ATM class of services, IP 
related information and so on.
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Cisco ANA understands and is able to derive the various paths on the network due to the up-to-date 
knowledge of the network. Cisco ANA PathTracer finds and retrieves the path of a specified service, 
after the user has selected a source and destination. The retrieved information contains, for example, all 
the network elements in path. 

Cisco ANA PathTracer enables the user to view multiple paths between the source and the destination 
in the Cisco ANA PathTracer multi-path window, or to view a selected single-path in the Cisco ANA 
PathTracer single-path window.

Opening Cisco ANA PathTracer
Cisco ANA PathTracer can be opened from an ATM VC, DLCI, or from an IP interface entry point. The 
virtual route is found according to the Cross Connect table of each ATM switch or Frame Relay device. 
The IP routing and path finding process is enabled according to the Routing VRF tables of each router.

In order to view a specific path you must specify an initial point like VPI/VCI, DLCI, Ethernet port or 
IP interface and a destination IP address (optional). If the user specified VC information or DLCI 
information, which ends in a router, Cisco ANA PathTracer finds the next hop according to the 
“destination IP address”. If the user did not specify the destination IP address the system uses the default 
gateway in the router. In addition, the related business tags that have been referred to the physical or 
logical entities are also displayed.

Note The path can also be opened if there is a business tag attached to an endpoint that can be used as the 
starting point for opening the Cisco ANA PathTracer.

The Cisco ANA PathTracer tool provides the user with two windows in which to view the path:

• Cisco ANA PathTracer Multi-Path Window—Displays all the paths available between the selected 
source and destination.

• Cisco ANA PathTracer Single-Path Window—Displays a single path available between the selected 
source and destination, as well as, the subscribers and properties.

The user can also enter the required destination IP address after opening the Cisco ANA PathTracer from 
the right-click shortcut menu at one of the following locations:

Element Location

Affected Parties • Inventory window

• Ticket Properties window (Affected Parties tab)

VC Cross Connect Table • Inventory window (Cross Connect dialog box)

Site • Service View map

IP Interface • Inventory window

• Affected entry

Layer 2 MPLS Tunnel • Inventory window

VC Table • Inventory window (VC Table dialog box)

Business tag • The path can be found using a business tag, which is attached to 
the VPI/VCI, or IP interface by entering its key, and it can then be 
opened from the Find Business Tag window.
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To open Cisco ANA PathTracer:

Step 1 Double-click on a device/element in the tree pane or map pane of the Cisco ANA NetworkVision 
window’s workspace,

or

Right-click on a device/element in the tree pane or map pane of the Cisco ANA NetworkVision window’s 
workspace to display the Device shortcut menu. Select Inventory.

The Inventory window is displayed.

Step 2 In the Physical Inventory branch of the tree pane, drill down and select the required port. 

Step 3 Right-click on the required port to display the shortcut menu and select PathTracer | From Here to IP 
Destination.

or

Open the Logical Inventory’s Routing Entity properties pane, right-click on the required element in the 
IP Interface tab, and select PathTracer | Start Here and PathTracer | End Here from the shortcut 
menu.

Note The “End Here” option indicates that when a certain point is selected as “End Here” the system 
extracts the relevant IP address from this point and uses it as the destination.

The Path Information dialog box is displayed.

Step 4 Enter the required destination IP address.

Step 5 Click OK. The Cisco ANA PathTracer multi-path window is displayed 

For more information about this window, see Cisco ANA PathTracer Multi-Path Window, page 9-4.

Step 6 In the Cisco ANA PathTracer multi-path window, select a path in the Paths pane.

Note If multiple paths are selected in the Paths pane they will be opened. If nothing is selected in the 
Paths pane, then all the available paths will be opened automatically, and each one will be 
displayed in a separate Cisco ANA PathTracer single-path window.

Step 7 On the toolbar, click Cisco ANA PathTracer. The Cisco ANA PathTracer single-path window is 
displayed showing the end-to-end path. 

For more information about this window, see Cisco ANA PathTracer Single-Path Window, page 9-7.

For more information about opening the Cisco ANA PathTracer from other Cisco ANA NetworkVision 
windows, and selecting multi-path options, refer to the section on Viewing Multi-Path Routes in VPN 
Networks in the Cisco Active Network Abstraction Managing MPLS User Guide.

Ethernet port • Inventory window

MPLS-TE Tunnel • Inventory window

Element Location
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Cisco ANA PathTracer Multi-Path Window 
The Cisco ANA PathTracer multi-path window displays all the discovered paths for the selected context, 
including devices, and physical links. 

The Cisco ANA PathTracer multi-path window enables you to perform the following functions:

• View a previous path or view the next path.

• Open the Cisco ANA PathTracer single-path window in order to view a single selected path.

• Save the multi-path map to a file.

• Run the Cisco ANA PathTracer again.

An example of the Cisco ANA PathTracer multi-path window is displayed below.

Figure 9-1 Cisco ANA PathTracer Multi-Path Window

The Cisco ANA PathTracer multi-path window is divided into the following areas:

• Cisco ANA PathTracer Multi-Path Window Toolbar

• Cisco ANA PathTracer Multi-Path Window Menus

1 Menu bar

2 Toolbar

3 Map path traced at...tabs

4 Paths pane

5 Status bar

6 Map pane
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• Tabs

• Paths Pane

• Map Pane

Cisco ANA PathTracer Multi-Path Window Toolbar
The Cisco ANA PathTracer multi-path window contains the following tools:

For information about the selection tools displayed on the toolbar, see Cisco ANA NetworkVision 
Toolbar, page 2-18.

Cisco ANA PathTracer Multi-Path Window Menus
This section provides a description of each option available in the Cisco ANA PathTracer multi-path 
window menus. The following menus are available:

• File Menu

• View Menu

• Shortcut Menu

Button Function

Selects the previous path viewed in the topological map pane.

Selects the next path viewed in the topological map pane.

Clears the path selection made in the topological map pane.

Opens the Cisco ANA PathTracer single-path window based on the path 
selected in the Cisco ANA PathTracer multi-path window. A map is displayed 
for the selected path, including NE details, links and property information. For 
more information, see Cisco ANA PathTracer Single-Path Window, page 9-7.

Saves the multi-path map displayed in the topological map pane. For more 
information, see Saving and Opening Cisco ANA PathTracer Map Files, 
page 9-13.

Defines the way in which the map is displayed in the topological map pane, 
namely, Circular, Symmetric, Tree, or Hierarchical.

Opens a window displaying an overview of the network displayed in the 
topological map pane.

Runs Cisco ANA PathTracer again creating a new map that is displayed in 
topological map pane tab. A new tab with an up-to-date (refreshed) path map 
is created for each run (the source and destination must be the same), with 
each tab representing a run, and its header indicating the snapshot time.
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File Menu

The Cisco ANA PathTracer multi-path window File menu is displayed with the following options.

Run Again

Runs the PathTracer again, using the same source and destination parameters.

Save

Save the map displayed in the Cisco ANA PathTracer multi-path window. For more information, see 
Saving and Opening Cisco ANA PathTracer Map Files, page 9-13.

Close

Closes the open Cisco ANA PathTracer multi-path window.

Shortcut Menu

The shortcut menu displayed in the Cisco ANA PathTracer multi-path window is context sensitive 
depending on the view and the NE selected. The Device shortcut menu is displayed when right-clicking 
on a NE.

For more information about the Device shortcut menu and for a detailed description of all the menu 
options available here, see Device Shortcut Menu, page 2-25.

Tabs
The path is initially displayed in the map pane in a tab that displays the starting point date and time of 
when Cisco ANA commenced the path tracing process (snapshot time). 

If you want to load a saved path from a file or run the displayed path again, a new tab with an up-to-date 
(refreshed) path map is created for each run or file (the source and destination must be the same). This 
is displayed in a separate tab, with each tab representing a run or file, and its header indicating the 
snapshot time.

Paths Pane
The Paths pane displays all the paths available for the selected source and destination (for each pair of 
source and destination a new path is created). The paths are displayed using numbers. Selecting a path 
in the Paths pane enables you to view each individual path in the map pane of the Cisco ANA PathTracer 
single-path window and the selected path is highlighted in the map pane.

Map Pane
The map pane enables you to view a route map of the intermediate network elements. The map displays 
devices, links and paths (topological paths).
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Icons are used in the map pane to display the network objects and these icons provide a visual 
representation of the network object’s status. For more information about the icons used, see 
Appendix A, “Icon Reference”.

Every link and node are labeled with the relevant paths numbers. The starting point is labeled with a 
special Starting Point label. All other edge points are displayed as clouds.

Cisco ANA PathTracer Single-Path Window 
The Cisco ANA PathTracer single-path window displays the devices and links of the discovered path, as 
well as path layer properties information in tables and subscribers. 

Note This section refers to single-path view only.

The Cisco ANA PathTracer single-path window enables you to:

• View a map of the intermediate network elements.

• View the following information for each network element:

– The relevant parameters for each interface on all layers along the path.

– For each layer an indication of a mismatch between the parameters of the interfaces on both 
sides of a link.

– View traffic statistics along the path.

• Monitor the status and traffic of all the links along the path.

• View In and Out port properties. 

In addition, right-clicking on an item in Cisco ANA PathTracer enables you to perform certain functions. 
For example, you can view device information, including device properties, and attach business tags.
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An example of the Cisco ANA PathTracer single-path window is displayed.

Figure 9-2 Cisco ANA PathTracer Single-Path Window

The Cisco ANA PathTracer single-path window is divided into the following areas:

• Cisco ANA PathTracer Single-Path Window Toolbar

• Cisco ANA PathTracer Single-Path Window Menus

• Topological Map

• Properties Table and Layer Tabs

1 Menu bar

2 Toolbar

3 Map pane

4 Hide/Display Properties table

5 Properties table

6 Layer tabs

7 Status bar
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Cisco ANA PathTracer Single-Path Window Toolbar
The Cisco ANA PathTracer single-path window contains the following tools:

Cisco ANA PathTracer Single-Path Window Menus
This section provides a description of each option available in the Cisco ANA PathTracer single-path 
window menus:

• File Menu

• View Menu

• Tools Menu

• Help Menu

• Shortcut Menu

File Menu

The Cisco ANA PathTracer single-path window File menu is displayed with the following option:

Close

Closes the open Cisco ANA PathTracer single-path window.

View Menu

The Cisco ANA PathTracer single-path window View menu is displayed with the following options:

Show All

Displays all the information in the Properties Table tabs.

Table 9-1 Cisco ANA PathTracer Single-Path Window Tools

Button Function

Displays all the information in the tabs.

Hides all the information in the tabs.

Exports the currently displayed data to a CSV file.

Starts exporting the counter values of the path displayed in the Cisco ANA 
PathTracer single-path window to a CSV file.

Stops exporting the counter values of the path displayed in the Cisco ANA 
PathTracer single-path window to a CSV file.
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Hide All

Hides all the information in the Properties Table tabs.

Tools Menu

The Cisco ANA PathTracer single-path window Tools menu is displayed with the following options:

Note This section refers to single-path view only.

Export to File

Exports the currently displayed data to a file.

Start Saving to File

Starts exporting the counter values of the path displayed in the Cisco ANA PathTracer single-path 
window to a CSV file.

Stop Saving to File

Stops exporting the counter values of the path displayed in the Cisco ANA PathTracer single-path 
window to a CSV file.

Help Menu

The Cisco ANA PathTracer single-path window Help menu is displayed with the following options:

Help Contents

Opens the Cisco ANA NetworkVision online help.

Help About

Displays application information, for example, the version number.

Shortcut Menu

The shortcut menu displayed in the Cisco ANA PathTracer single-path window is context sensitive 
depending on the view and the NE selected. The Device shortcut menu is displayed when right-clicking 
on a NE, as displayed.

For more information about the Device shortcut menu and for a detailed description of all the menu 
options available here, see Device Shortcut Menu, page 2-25.

Show ‘In’ Port

Highlights information regarding the In Port (the in port of the device in the path)of the selected network 
element in the Properties table of the Cisco ANA PathTracer single-path window.
9-10
Cisco Active Network Abstraction NetworkVision User Guide, Version 3.6

OL-12500-01



 

Chapter 9      Working with Cisco ANA PathTracer
    Cisco ANA PathTracer Single-Path Window
Note This option is only available in the Device shortcut menu in the Cisco ANA PathTracer single-path 
window.

Show ‘Out’ Port

Highlights information regarding the Out Port (the out port of the device in the path) of the selected 
network element in the Properties table of the Cisco ANA PathTracer single-path window.

Note This option is only available in the Device shortcut menu in the Cisco ANA PathTracer single-path 
windows.

Topological Map

The topological map displays the devices and links that are part of the path. Icons are used in Cisco ANA 
PathTracer to display the network objects and these icons provide a visual representation of the network 
object’s status. For more information about the icons used, see Appendix A, “Icon Reference”.

For more information about the colors used to indicate severities, see Map Pane, page 2-7.

The same coloring conventions that are used in the map pane of the Cisco ANA NetworkVision window 
are used to display links in the Cisco ANA PathTracer single-path window. Selecting a device or link on 
the map automatically highlights the related parameters in the table.

Note The color of a selected link is customizable. The default color is blue.

There are three ways in which the status of a network object is indicated on the topological map:

1. By severity

2. By management state

3. By new alarms 

For more information, see Status of Network Objects, page 2-15.

Properties Table and Layer Tabs

The Properties Table and tabs displays the supported parameters of the specified NE. The Cisco ANA 
PathTracer single-path window is divided into tabs as shown in the example in the Cisco ANA 
PathTracer Single-Path Window, page 9-7.

The information parameters are displayed in a table, with the ingress and egress ports on the top and the 
parameters on the left.

Any inconsistencies between the two connected ports are colored to emphasize a discrepancy, for 
example, different admin statuses.

The Cisco ANA PathTracer information parameters are arranged in groups as follows:

• Networking Layers—This group displays information regarding each network element including 
ingress and egress port information. The information is either plain data that was extracted from the 
device or calculated data such as rates or statistics. This information is displayed in the Layer 1, 
Layer 2 and Layer 3 tabs.
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• Business—This area displays the name and the key of the business tags that have been attached to 
the network entities displayed, namely, the port or the entire device (physical entity), VC, VP, DLCI, 
context (logical entity) or MPLS. This information is displayed in the Business Tag area.

The Cisco ANA PathTracer window is divided into the following tabs and all appear empty when the 
window opens:

• Layer 1—Displays the Layer 1 information in the selected path and enables you to view the link 
parameters. The name of each device is displayed, as well as, the sub-slot, slot and port details. 

• Layer 2—Displays the Layer 2 information in the selected path. In addition, it enables you to view 
the link and connection parameters. For each of the devices, the name and MAC address is 
displayed, the VPI/VCI in an ATM link, or DLCI in a Frame Relay link. By default, the Cisco ANA 
PathTracer single-path window is displayed with the Layer 2 tab active. 

• Layer 3—Displays the Layer 3 information selected path and enables you to view the link 
parameters. The name of each device is displayed.

• Business Parameter—Displays the name and the key of the business tags that have been attached 
to the network entities displayed, namely, the port or the entire device (physical entity), VC, VP, 
DLCI, IP interface or context (logical entity).

For specific information about VPN Cisco ANA PathTracer information refer to the section on Viewing 
VPN Cisco ANA PathTracer Information in the Cisco Active Network Abstraction Managing MPLS User 
Guide.

Viewing Path Information 
The Cisco ANA PathTracer tabs display information regarding each network element including ingress 
and egress port information. The information is either plain data that was extracted from the device or 
calculated data such as rates or statistics. This information is displayed in the Layer 1, Layer 2 and 
Layer 3 tabs of the Cisco ANA PathTracer single-path window. 

To view path information:

Step 1 Select the required tab, and click Show All. The path information is displayed in the active tab of the 
Cisco ANA PathTracer single-path window.

Note Selecting a device or link on the map automatically highlights the related parameters in the table.

Note Drag the scroll bar at the bottom of the Cisco ANA PathTracer window to view the various areas of the 
selected path and the parameters.
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Saving and Opening Cisco ANA PathTracer Map Files
Cisco ANA NetworkVision enables you to export the maps (paths) displayed in the Cisco ANA 
PathTracer multi-path window to an .xml file. The data can then be viewed at a later stage in order to 
assess whether anything has changed.

To save Cisco ANA PathTracer Map Files:

Step 1 Open the Cisco ANA PathTracer multi-path window.

Step 2 On the toolbar, click Save,

or

Select Save from the File menu.

The Save dialog box is displayed.

Step 3 Browse to the directory where you want to save the file.

Step 4 In the File name field enter a name for the map file.

Step 5 Click Save. The map file is saved in the selected directory.

Cisco ANA NetworkVision enables you to open saved xml format path-tracing maps.

Note • When the user loads a multi-path file, Cisco ANA queries the file (not the network), and loads all 
the persisted information. 

• When the user loads a multi-path file that does not contain the same “start here” and “end here” 
destination information, the map is automatically opened in another instance of Cisco’s PathTracer.

To open Cisco ANA PathTracer Map Files:

Step 1 Select Load PathTracer from the File menu in the Cisco ANA NetworkVision window. The Open 
dialog box is displayed.

Step 2 Browse to the directory of the saved file and select the file.

Step 3 Click Open. The Cisco ANA PathTracer multi-path window is displayed with the previously saved map 
file.

Saving Cisco ANA PathTracer Counter Values 
Cisco ANA NetworkVision enables you to export the counter values of the path displayed in the 
Cisco ANA PathTracer single-path window to a CSV file. The data can then be viewed at a later stage.

Note This section refers to single-path view only.
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To save Cisco ANA PathTracer counter values:

Step 1 Open the Cisco ANA PathTracer window, see Opening Cisco ANA PathTracer, page 9-2.

Step 2 On the toolbar, click Start Saving to File,

or

Select Start Saving to File from the Tools menu. The Export Table to File dialog box is displayed.

Step 3 Browse to the directory where you want to save the Cisco ANA PathTracer counter values. 

Step 4 In the File name field enter a name for the Cisco ANA PathTracer counter values.

Step 5 Click Save. The Cisco ANA PathTracer counter values are saved in the selected directory.

The user can then stop exporting the counter values of the path displayed in the Cisco ANA PathTracer 
single-path window to a CSV file.

To stop saving Cisco ANA PathTracer counter values:

Step 1 On the toolbar, click Stop Saving to File,

or

Select Stop Saving to File from the Tools menu. 

Cisco ANA NetworkVision stops exporting the counter values to the CSV file.

Rerunning a Path and Making a Comparison
Cisco ANA NetworkVision enables you to save and load a path (see Saving and Opening Cisco ANA 
PathTracer Map Files, page 9-13). This file can then be used at a later stage rerun the path automatically 
using the same source and destination. You can then compare the paths for example, if you suspect that 
the path has changed and assess where the problem is occurring.

To rerun the path:

Step 1 Load the required map file, see Saving and Opening Cisco ANA PathTracer Map Files, page 9-13. The 
Cisco ANA PathTracer multi-path window is displayed with the previously saved map file.

Step 2 On the toolbar click Run Again,

or

Select Run Again from the File menu.

The path reruns automatically using the same source and destination as the loaded map file and a new 
tab is displayed in the Cisco ANA PathTracer multi-path window with the updated map (path). The tab 
also displays the updated details of the date and time when the path was rerun.

The user can easily compare the two paths by simply switching between the tabs in the Cisco ANA 
PathTracer multi-path window and comparing the old map (path) with the new updated one.
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Note • When the user loads a Cisco ANA PathTracer map file that does not contain the same source and 
destination information as the map that is currently displayed in the window, the map is 
automatically opened in another instance of the Cisco ANA PathTracer multi-path window.

• If the user loads a Cisco ANA PathTracer map file that contains the same source and destination 
information as a window which has already been opened, the file will be loaded in a new tab within 
this window.
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